ASDMY S 4 AL A—H—A 3 —Dzx
4R

ZOETIE., ASDM 2—H— 4 v Z—T = 4 ZADFEHHFIEICONTHB L ET,

¢« ASDM t—H'— A L H—T = f Z|ZHONT (1 2—)

¢ ASDM 2—H'— A U X —T =2 f ADFT o —rar (43—)
s Azma— (5—Y)

o« W — )L x— (13 X—Y))

* ASDM Assistant (14 ~X—3)

e AT —H A )R— (14 =)

* Device List (15 ~X—72))

@R Z L (16 2—2)

e F—R—FKDva—rby b (173=Y)

« ASDM <A v DR (19 X—)

o L—)L U R N ORERERE (20 <X—2)

cJEEA 7 UV —2 U= HR—FOHFME 21 =)
cHEPIH T AN A — (21 =)

« [Home] XA > (Vo7 EF—RLarrxah) (21 4—Y)
« [Home] A > (VAT L) (36 %—Y)

« ASDM X EDEFR (38 ~X—)

« ASDM Assistant TORFE (41 ~<—)

JBEA MU v OFME (41 =)

e R—FEN TRV a<r B (42 =)

ASDM 11— — 4 32— 24 RIZDWVT
ASDM L —W'— f U Z—T =4 AT, ASAWNYAHR—FLTWVDE S FEIEREREICFERICT 7

TATELLIICKRHENTWET, ASDM 22— — A U H —T = A ATITRDOEZRH D
i—a_o

ASDM 5524 AL a—4—1v4—7z42 ||



ASDM 5574 AL 1—H—(v8—Tx(Z |
B rssomai—y—qos—ozqzizo0T

c T AN, V—Ib, AP —F, BIOANNAICT STV EATEA A= a— 13— R
—a—HADOEZIEF—AR—F a— by rbdHDET,

« ASDM OFED T2 DY — )L r3—_ Y —)Ls3—7) 5 [Home] <A >, [Configuration] <A
v, BE O [Monitoring] XA VNZT 7 EATEET, /o, ~ATORBEONA UEOT
v —va b TEET,

o N2 ZRHE7AR 2O [Navigation] X >/, [Configuration] X > X> [Monitoring] <A1 >
WOBENERALEST, ~v X —IlHD35ORZ L 2ZnNThr Vv rdbE, M2
DERRACEIIEITT, BEAGER T B —T VT A ~DOEHR, <A OHFRFE, &
TI_A U E LD Z L3 T& £9, [Configuration] ~ >3 X U [Monitoring] ™A1 /127
7 AT HITIE, ROWTNEFEITLET,

TV r—ay vy RO S H /MO [Navigation] <A DY 7 %7
Vw7 LEd, IR L [Content] XA DX A MR —ZRANFRENET
([Configuration] > [Device Setup] > [Startup Wizard] 72 &)

o IEfE7R /S 2N 0o TV DA, MO [Navigation] XA > T2 %7 ) v 7 L7
KTH, 77V r—var vagery FyOEMINZH S [Content] <A D F A FL/3—
ICEEASITEET,

o 7240l @ [Navigation] A > % FEFKR/FK R TE 5 [Content] <A > DA ¥iIZ & % [maximize and
restore] 7N 2,

o K& 7 aHE7: [Device List] ~A >, ASDM BT 7 BATE BT /84 ZADY A M &R
RLET, ~vH—IlHDIODRL U EHENETNI Y v I THE, XA UDORRIEET
IXE T, BEIRTRER V0 —TF 4 TR U DEE, N DR, £E R
LD ZEMTEET,

o BRI, $EAT —H A, 2—HP— AFY AT —H R FTar 74 FXal—a R

F—H A MERLL, BIOSSL AT —F 227 FVr—ay 7400 RUDTEIC
FTRTHAT —H A /N—,

« 72l [Navigation] XA >, 7 7 A b=/l NAT /L—/b, AAA L—/L 7 4 LK JL—
. BEOY—E 2 L= LOERERCL—L T—T L THEATELSESER ATV
I RNEFRRLET, XA VHNOXT XA MLiE, R L TWHEREICIE L TEDY £,
T2, 2D ZIE ASDM Assistant 28 F R S E T,

WDOKNZ, ASDM 2 —H'— 4 X —T 24 ZADBEFEERLET,

B ASMSS T4 AL aA—H—A28—T(R



| ASDM Y574 hLa—F—a08—T14R

AsoM 12—+ — 4 > 5 -7z 21=o0T [

1:ASDM1—H— A VB2 —T (R

@ @G @

€ | I File View Tools Wizards Window Help [
[@eo® Cisch ASDM 88.30(0)52 for ASA - 10.89.5.26 v
e Teect Y S corward | B ne tonid M
@ Hume L] Monitoring [a Deploy Refresh o Back o v n.) Help | Type topic clseo
—Device List- iGRkialiay O Configuration > Device Setup > Startup Wizard
000 Device List
% Add 0 Delete & Connect
Eind Click the "Launch Startup Wizard” button to start the wizard.
mna:
& 10.31.118.175
&l 10.82.109.113 Startup Wizard
3 10.83.45.103 The Cisco ASDM Startup Wizard assists you in
= 10.83.45.122 getting your Cisco Adaptive Security Appliance
=l 10.83.58.239 A configured and running. Use this wizard to 8
= 10.86.118.1 create a basic configuration that enforces
a w:%:“a:z security policies in your network.
A The Startup Wizard can be run at any time and
&) Device Sel - SR S "
| _OO LN — will be initialized with values from the current
CIO running cenfiguration.
» B} Interface Settings
b 43 Routing
& Device Name/Passwold
@ Key Chain

&2 CGNAT MAP
» e System Time
A

| % Firewall

gé Remote Access VPN

@ Site-to-3ite VPN

=3 AsA FirePOWER Configuration

gé Device M

|- Launch .‘.)lanup Wizard ,

|

[ 4 3 LA @[ [10/8/20 5:40:53 Pm UTC
® ® ® ®

L6l

GUI EX% &

1 A= a— N

2 Y — LN —

3 FEHF =g RR

4 Wk 7 4 —N K

3 EMOF BT =g~ v

ASDM 5574 AL 21— — A3 —T (4 X .



ASDM 5574 AL 1—H—(v8—Tx(Z |

B rssoma—y—vos—ozqz0resr—vay

\}

GUIER & EA

6 [Device List] ~21 >
7 [Content] ~XA >

8 AT —H A IN—

G¥)

Y —/L b A3, [Wizards] . [Configuration] ~X4 >, [Monitoring] XA >, AT—H X /\—%
e, GUIOS ESERMMTBMENTVNET, Y=L bV FERFT DL, v TR E
AT =L ANRNIHDT A avipl| BEOZ—Y— A U F—T 2 AZHRO LIZES ET,

ASDM 21— — A U3 —TJ (A ADFES—a Y

ATy T

ASDM Z—H— [ Z—T = 4 Z%FRANBENT D7D, BIOHETHIA LA =2 —,
V== Ry XU THEEEAA B K OVEM & Al [Navigation] ~A &k AAH T
fEFCE 9, HHTE 2HEEIX. [Device List] XA > D FDORHZ U A MIFERINET,
U A ML, IROMEER Y VB A TWDEERH Y 7,

* Device Setup

* Firewall

* Botnet Traffic Filter

* Remote Access VPN

* Siteto Site VPN

« Device Management
TRINDBEERZ DU X M BALLE T A B ZERBICESHTERESNET, =2~
T4 X alb—vary Ea—FRFE=4—U T Ea—O@&R LIMEORYIDSA T

IR ATDHITNE, ENENORZ %7 ) v 7 LET, BA—A Ea—Tld, HiER ¥ 13
TEEEA,

WRBER 2 L OFRTRELEZDHEIE. WOFIRZFEITLET,

FIE

BEDOHEEERZ O TIZHD Ry XA VA NRAVERBINLT, 20T F AN A=a—
BFRRLET,

ATV T2 ROWTNILDOF T a BRIV LUET,

« FORT DR HF U &EERLTITIX, [Show More Buttons] 27 Y v 27 LE9,

B ASMSS T4 AL aA—H—A28—T(R



| ASDM Y574 hLa—F—a08—T14R

A=a— .

« FoRTLHRZ &P HTITIL, [Show Fewer Buttons] 27 Y v 7 L ¥ 7,

o RH U EBINE 72 I1XHIBR T 521X, [Add or Remove Buttons] 27 U v 7 L, FRrShizV
A NP OIBIMEZITHIRT AREZ %227 ) v 7 LET,

* [Option] Z# &R $ % & [Option] XA T a2 VR v 7 ANREKRI, RE DU A NBEIED
B CRIRINET, KOWTIOZETIRLET,

s URAMNNDORYZ % BIZBEIT 512X, [MoveUp] #727 U v LET,
s YA MNNDORYZ % FIZBEIT 512X, [Move Down] #7 U v 27 LET,
« UA NOHBEDNEF%2T 7 4V FEREIZETIZIL, [Reset] #7 Vv 7 LET,

ATY T3 [OK 27V w7 LTREEZRTF L, XA 7l Ry A=A LET,

AT a—

ASDM DA =2 —2iF, ¥ T AFERIFF—AR—FR2EHLTCT 7R TEE T,

[File] * =2 —

[File] * ==—TlX, ASADa> 7 4 Fal—a V2 EHTEET,

[File] # =1 —IEH BLL]

Refresh ASDM with the FTar 74 ¥al—varnat—4%ASDMIcr— KL%
Running Configuration on the | 4
Device

o

Reset Deviceto the Factory AL T 4 XL — g vk TEHEROF 7 40 MOETE L
Default Configuration F94

Show Running Configurationin | ifE D34 Tar 7 4 Fal— a b 2H LNV > RYicE
New Window TLET,

Save Running Configurationto | 2472 7 4 ¥al— g oDabt—% 75 v o AEJIZ
Flash EXABET,

Save Running Configuration to | SR7EDFEITa L 7 4 X2 l— g 7 7 A )LD a ¥’ —% TFTP
TFTP Server P S TRAE L E T

Save Running Configurationto| 75 4 < VEEOETa Ly 7 4 X2l —T gy 77D
Standby Unit B, Tx— AR RF UL EEORE T T 4
Fal—vaXELET,

ASDM 5524 AL a—4—1v4—7z42 ||



ASDM 5574 AL 1—H—(v8—Tx(Z |

B view x=2—

[File] * —2—I&H & BA

Save Internal Log Buffer to NEFa s Ry 7752 7Ty a AERVICHEIFELET,

Flash

Deploy Firepower Changes E Y2 — /L% L CTiT > 72, ASA Firepower € = —/L 7R U
VA OREELERFELET, 0T v a U E, ASA
Firepower €3 = — /L% A > A h—/L L C, ASDM CEHT %
EXWZDOMEMTEET,

Print BAEDN—DZERI L £, V—AZEIRIT 558, _—
RTINS T 5 2 & &9 LE T, Internet Explorer D355
i, BAMNE T T Ly b ERRANAKTR U TR A CHIBIAE R 23
B2 b6 THWET,

Clear ASDM Cache 2—71/L ASDM A A — Y ZHIBR L £3°, ASDM IZHHiT 5
ELASDMIZE D A A=V B —h Iy ra— REnE
j—o

Clear ASDM Password Cache | L\ W2 U — K& EFK LIZKIC, ThEIZRARDBEFED S
AT —= RBREEES> TWL5EIE, NAV—RFFrvian
HIBR L £,

Clear Internal Log Buffer syslog A v B— Ny 77 2RI LET,

Exit ASDM ZPAU £ 7,

[View] A =1 —

[View] A == —TI|X. ASDM =

— P (=T 2 A ADSESE R ERFTEET,

BEOL 2— S UIHEDHEANERINET, BEOE 2 —|ZFRTERWIEB IT®IRT

TEFA

[View] * =21 —I8H

A

Home

A—Ah Ea—%FKRLET,

Configuration

a7 4 X2l —varta—%FRLET,

Monitoring F=H =V T Ba—%FRLET,

DeviceList K %2 VHEERAA VNZTF AL 2D Y A b
ERALET,

Navigation a7 4 F¥al—rarta—RBLE=4—

Y > 7 ¥ 2 —T [Navigation] <A & &R E
ToIIEFRRIC L ET,

B ASMSS T4 AL aA—H—A28—T(R



| ASDM Y574 hLa—F—a08—T14R

iew] x =1— [Jj

[View] * =1 —IEH

B

ASDM Assistant

2 27 U= ASDM O FiED~ LT %
B L, RoTE 9,

Latest ASDM Syslog M essages

A —2A B 2 —C [Latest ASDM Syslog Messages]
NA U FORETIIEERICLET, 2o
A 0F, A=A Ea—TORFEHTEET,

BAHTDOY ) =2 T v T T — R 572D
AFYUDBRELTHDLEEIT, syslog A v E—
¥ %ASA-1-211004 AR S HL, A A h—)b
SNTWHAEY | BIOMERAEY BR
ENFET, TORAvE—=VE, ATINRT v
T — RINDHET, 24 K 2 L ITHER
SNET,

Addresses

[Addresses] <A » & FREILILIFFRRIZLE
9, [Addresses] <A U, I T 4 F 2L —
a3 B o —® [AccessRules], [NAT Rules].
[Service Policy Rules], [AAA Rules], B L O
[Filter Rules] XA > COREHATE £,

Services

[Services] <A & R/RETIIIFELRRIT L E

9, [Services] <A L, AT 4 F =2 L —

g v B a—®d[AccessRules], [NAT Rules],
[Service Policy Rules]. [AAA Rules], X
[Filter Rules] ~<1 > CORFEH TE £9°,

Time Ranges

[Time Ranges] <A > ZF/R E T2 ILIEFRRIZL
%9, [Time Ranges] A L, 27 ¥ 2
L —3 3 » B =2 —0® [Access Rules], [Service
Policy Rules], [AAA Rules], 3 J O [Filter
Rules] A ' TORMBHTE 9,

Select Next Pane

N IVF A T TIROSA e R R L
F9, 72 & ZIiE. [Service Policies Rules] ~A
VN ZEDEED [Address] A B EIL F
j—o

Select Previous Pane

< JLF A TEETTRIO A 2 giFRoR L
*9,

Back BIDR_A TR Y 17,
Forward PIRMC R R LTZR DS BB LET,
Find in ASDM HEBER° ASDM Assistant 72 EDIE B 3R L F

R

ASDM 5524 AL a—4—1v4—7z42 ||



. [Tools] A —a1—

ASDM 5574 AL 1—H—(v8—Tx(Z |

[View] * =1 —IEH

B

Reset Layout

VAT I RNET 74N RO T 4 X2 Lb—
YaZRLET,

Office Look and Feel

B 7 4 > k & 4.% Microsoft Office 5% &2
EELET,

[Tools] * =1 —

[Tools] A ==—I%, ASDM Tl C& AkD—

DY — /L ik L Ed,

[Tools] A =1 —I1EH

B2l

Command Line Interface

a2 K& ASAIZEE L TR EZFRRLE
7,

Show Commands I gnored by ASDM on Device

ASDM IZEH SNV R — had&stoa~<
FaEafRRrRLET,

Packet Tracer

BELEEELT RLAEAL VH—T A R
MBI ET, Ny Fe hL—ALET,
v harBIOR— T —% XA 7IZH
PORIBETE, T CEITINTAED
R — 2 B E TNy N O—H AR B 2R
TEET, WL, 77 AT U4 —
NWORETA RESRLTIIEI0,

ping

ASABLUOBRT 2lEY v 7 DT 4 Fa
L—3a URREMEARRGEL . oy FU—
I TNA ADIERN 2T A M EFATLE T,
PRI OWTIE, 77 A T U A — VDR EN
A4 REZHRLTIEEN,

traceroute

Ny NRSEAEICEIE T HETONA— N EH
WrL£9, FEMc>WTIX, 77 AT U —
IWDOBRETA REZR LTI,

File Management

7Ty va ARVIRESINZ 7 7 A VER
R, Bl av— BLOHIBRLET, /-,
7Ty va AEVIZT 4 L7 R EERT D
T TEEY, E7/2. TFIP, 75 v 2 A
EY, B—HILPCREIEFIERT 7 AL
VAT LRBITT 7 A MiRENRTE ET,

B ASMSS T4 AL aA—H—A28—T(R



| ASDM Y574 hLa—F—a08—T14R

ools] x=1— [Jj

[Tools] A =1 —IEH

B

Check for ASA/ASDM Updates

TAYP—FREHFHLTASAY 7 b =T HB XL
WNASDM V7 "N =757 v 77 L —FKLE
—a—o

Upgr ade Software from Local Computer

ASA A A—, ASDM A A —3, Fi-lda—
P—PCOMDA A—THTTvia AEY
W7 v 7 a—RKLET,

Downgrade Software

BAFEITHFOLDOLD HIHWASAA A—V%
r—FLEY,

Backup Configurations

ASAD a7 4 F a2 l—3 3, CiscoSecure
Desktop £ A —<7, 3 J ¥ SSL VPN Client
A=TUBIONTaT7 A NERNy I T L
i‘a—o

Restore Configurations

ASAD=L 7 4 ¥ 2L —3 3>, CiscoSecure
Desktop 1 A —37, ¥ TV SSL VPN Client
A—=VBIOTun 7 s A vEETELET,

System Reload

ASDMZHEEL, fRELIZay 7 4 X2 Lb—
varvEAEYIZ)u—RKLET,

Administrator’s Alert to Clientless SSL VPN
Users

EEEIN, 7T 47 b LA SSL VPN = —
PelZ T F— b A b—UERETEELD
(CLE9, FEMICOWTIX, VPNAER T A K
LTSI,

ASDM 5524 AL a—4—1v4—7z42 ||



B wizards) x =2 —

ASDM 5574 AL 1—H—(v8—Tx(Z |

[Tools] A =1 —IEH

B

Migrate Network Object Group Members

RILIRICHATT D556, ASAITAHIfTE xR v
NTD—2 FT7 V=7 FEERL T, —H O
REDA T4 IPT RLAZEEXHZ T,
AT EA TV =7 MTIMA T, ASDM (I =
Y74 Xal—varyTHEASR TS TR
TOIPT FL AR LTARIR LA T V=
NEBHERICER L ET, 2D 0 HEMER
INBATV T MIIPT RLRIZE->TD
HaB S, LRI, Ty M T A — A
RECALHMTEAT V27 e LTIFEL
FH A,

BATO—E & LTARIMTE AT V=7 F & ASA
WERT %6 . 68T 24 AT & ASDM
A7V =7 NI, ARift&EF 727 b
WCEHSNET, HE—ofsME, Y FU—
U F T2l b IN—TOIAFIUSE AT
VxJ hTH, XYy NIV—=I ATV T
N—TRNIZHDIPT KL ADA4HIFTE AT
V=7 N ASADMERT H856 . ASDMIZIE
AT EA TV VMR LT E £, EHE
L7eA 7 Y=/ h% ASDM TIER L £3, =
NoDOAF Tzl Ne~—TF 5T, [Tools)
> [Migrate Network Object Group Members] % %
NLET,

FEABIZ DWW TTIE, [Cisco ASA 5500 Migration
to Version 8.3 and Later] &M L T Z &0,

Preferences

g UETORED ASDM HERE DB E A

ASDM Java Console

Java 2 Y — )V EFRRLET,

[Wizards] A =1 —

[Wizards] A ==2—IZ XV,

S E S E kR

RETDHV AP —FEETTEET,

[Wizards] #* —1—IEH

AEA

Startup Wizard

ASA O E = BBEIIZ T A RLET,

VPN Wizard

SFEXERVPNHREHOY 4 F— KRS
NTWET, FEHICOWTIL, VPN HEER T A
REZB LT ZEW,

B ASMSS T4 AL aA—H—A28—T(R



| ASDM Y574 hLa—F—a08—T14R

[Window] A =1 — .

[Wizards] * —1—IEH

B

High Availability and Scalability Wizard

7 2 A N DOFBGENAREIC A2 ) T
VPN FAH u— RNZ v JEIZITASA
EDASA 7 FAHBY T

Unified Communication Wizard

ASA LT, IPEHFERED2Z=T7 7 Fala
== a UEREDORENAIREIZR D £77,
PRI OWTIE, 77 A T U A — IV OKEN
A4 FESHRLTLIEEN,

ASDM Identity Certificate Wizard

Java 7 Update 51 LM 2 256 . ASDM
T F X I IHMEETE DREHE NP LE T,
AEAEOEMRL, HOEAN EDOIDFEHEL
A VAR—=NT DI LI Lo TREICHZ 9
TLEBRTEET, 2OV 4P —FEEMALT
REEAZ A A =)L T % F TlE, Java Web
Start Zf#i[] L T ASDM Z B35 Z L A Tx
F9, FEMICOWTIE,

http://www.cisco.com/go/asdm-certificate % 2Pt

LTS,

Packet Capture Wizard

ASA ET, "oy b Xy IF X OFKEN AIEE
R0 ET, ZOU o F— R, A1~
B —T A ADFNENT/NT Y Ny I TFx
ZIEFATLET, F¥ 7 F v DETHE, v
TFxEara—XIRfFL, Xy R T
FTIAVEFRH LTy 7Ty 2REBLIO
IHTCTEET,

[Window] * — 21—

[Window] A ==a—%fH LT, ASDMD Y ¢ > RUBEBEICEXES, 77747y 1
RUMMBEBREINZT 0 RO L LTEREINET,

[Help] #* = a1 —

[Help] A =2 —TiX, T4 ~VT~DVY 7 Oz, ASDM & ASA OfF#R bRt

£,

ASDM 5524 AL a—4—1v4—7z42 ||


http://www.cisco.com/go/asdm-certificate

B

ASDM 5574 AL 1—H—(v8—Tx(Z |

[Help] A =2 —IEH

B

Help Topics

HLNT TV 70> RN TASDM O
T TA IV IREKRSIET, ASDM T
ASAFirepower &Y = —/LEEFIH L TWDE5E
L. Z DI HIZ [ASDM Help Topics] &5 7
NUPERSINET,

ASA FirePOWER Help Topics

HLWT T v FUBBWT, ASA
Firepower & ¥ = — /L DAL T A 2 ~ILTHRFK
RENET, ZTOHHEIL, ASDM TEY 2 —
NWaA A N—)L L TEELTWALEHEICE
TEHTEET,

Help for Current Screen

FREH TN D E BT 2 Rk A~ L7
NBE 9, £720X, YV —/L =D [? Help]
NE s )y 73D TEET,

Release Notes

Cisco.com {Z& 5 i/ N— 2 > D [ASDM
release notes] P& £7, VU —R /—}FIZ
[F. ASDM DY 7 hy =T En— Ry =T H
HofRHEHR, BLOY 7 by o7 EHICH
T HEAIHERP LI TWET,

Cisco ASA Series Documentation

AFfRER TR TOBE v =T L~D Y >
7 & te Ciscocom FD K= A2 AP E F
j—o

ASDM Assistant

Cisco.com 6 & 7o — RA[fERa T Y
B TX, BEDHY AT DFEITICETHEE
M2 7D ASDM Assistant & B & 97,

About Cisco Adaptive Security Appliance (ASA)

V7RI =T =T g N— KT =T,
AP — T TR — &b ar 7 4 ¥
L— gy T7ANRY T NI 2T A A=
7o&, ASAICEET AERERRSLET, Zh
DIX R TTNya—T 4 T ORI DT
WTT,

About Cisco ASDM

VT RNT =T N—=Var, RANL, HERL
N, ARV =T T VAT A, TRA R
2 AT, JavaDX— 3 7Y ASDM 1214
THEMER T LET,

B ASMSS T4 AL aA—H—A28—T(R



| ASDM Y574 hLa—F—a08—T14R

W—)L/\—

v—nri— |

AZa—DFIZHDHY—ILIN—E, F—A bEa— a7 FXal—alrta— BX
PNE=F—V T Ba—ZT7 7 8ATEES, £, vV TF 2 7TFANE—RFNTUVAT A
X2V T4 I THFAMEEIRLEZY, TS =V g U BXUOFOM I F T D HEGE

ETCEET

Y—JLIN—RE

A A

Home

A H =T 2 ADAT—H A FITHOR—Tar, T4 AF
W, RNTF—v AR ASA DEERFH A F R TE S [Home] ~
A EFRRLET, AT T— ROEA. [Home] <A UiEHV £H
}\Jo

Configuration

ASA 7% E LET, Ao [Navigation] XA > DRERER X %7 U »
7 L THEREZ R E LE T,

Monitoring

ASA ZE=#— L F7, LMD [Navigation] A1 > DHERER ¥ % 7
Vw27 LT, SEIFEREREFET=FX—LET,

Save

EXALT VT ARARERI L TX A MIRY, Ef7ar7 4 ¥=
L—Yav b AX— T v a7 4X¥al—arb UTRIFEL
i—g—o

T34 A F|Z ASA FirePOWER EY =2 — /LA VA =L I TE
0. FTiZE ASDMIREH CTRE L TWAHHEAIL. Z DR 2 [Deploy]
R AEZXHBZONET,

Deploy

F 84 A 1T ASA FirePOWER & 2 — LW A v A M— L ENTH
V. ASDM %k THIE L T LH%E1E, [Deploy] 7% & [Save] R
2o hkiEEZ, WOATvarkEgihEiqd,

* [Deploy FirePOWER Changes] : €3 = —/LIZx9 5 ASA
FirePOWER & ¥ 2 —/L R Y L —~OFELEH 2RI L ET,

* [Save Running Configuration to Flash] : ASA 727 4 ¥ =2 L —
varPav—x7Jyva AEVICETALET, JiiL,
ASA FirePOWER & = — /L& & £ 72T /31 2D [Save] R ¥ v
L RIFETY,

Refresh

RAEDFETI L 7 4 Fa2al—2 a2 TASDMZY 7L v 2 LET,
72720, F=X—Y T RADTT7FZV 7y a LET AL

Back

HRNZER L7 ASDM D21 VIZEY $£1,

Forward

ELRTIZZR L7z ASDM D31 IR £,

Help

FORRTERRIN TS HEEOKRREGF~N T ERRLET,

ASDM 5524 AL a—4—1v4—7z42 ||



. ASDM Assistant

ASDM 5574 AL 1—H—(v8—Tx(Z |

Y—J)LIN—RE

B

Search

ASDM N THEREZ R L £ 9, MERKEEIXZ, X1 DF A MLvET
RTHRBELTCBHBAEERRLET, M=V T 52T Vv IT 5D
LY, U BICR R SIVET, [Back] £ 7213 [Forward] %
2V THE ML 200, U ETIERLEI0 L 52 LR
TEET,

ASDM Assistant

ASDM Assistant Cl&, # A7 2 U7z ASDM OFERFIEO~NVTEHRBE L, FRTEET,
COMEEIX, VNN arTHRRARNEVAT A AVTEFAIDOL—T vy R E—RBIOMT
VAT L N B— RTCHHTEET,

[View] > [ASDM Assistant] > [How Do | ?] DNEIZER T 57>, A ==2—/3—0 [Look For] 7 4 —
VRNBBE) 72 A P EAN L TIHERICT 7B ALET, [Find] Ry 727 UMb
[How Do 17] &38R 5 & | MR L £ 7,

ASDM Assistant Z 3 5121, ROFIEEZETLFET,

FIE

AT w71 [View] > [ASDM Assistant] Z &R L £,
[ASDM Assistant] <4 > NERRINET,

AT 72 [Search] 7 4 —/b RICHRBRET HEMAE AN LT[Gol &2 Vv LET,
BR X7 #S [Search Results] XA NZFE RSN E T,

AT 73 [Search Results] i1+ L O [Features] fEIKICE R ENDEEDOV 27 %27 U v 7 L, abfifE®R

ZAFLET,

ART—RRX IN—

k=11

AT—RRAN—ZTADSM 7 4 > RUD FEICERINET, ROKIZ, ENLHIZETRIN

L E R L ET,

7

B8

Status

a7 4 F a2l =YgV DAT—H R
( TDevice configuration loaded successfully.| 73
E) o
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Connection to Device .

Y7 39

Failover T rx— VA —R=MEEDODRT—H AT, T
T AT EIZAE XA DT I,

User Name ASDM . —H—pDa—HF—4, 2—H—47
Lca s A v Lizha, 2——4ix
ladmin] T,

User Privilege ASDM == —H% —DFFHE,

Commands | gnored by ASDM TAarxs )y 3 5HE, ASDM TULH S

Nppol-ar 74Xl —yagroavy
FOU R MBRERENET, ZhHDa~<
Rz 74 Xal—arhbliRans

A,
Connection to Device ASDM @D ASA & Ot AT — X A,
Syslog Connection syslog #Efe S EIE L TH D . ASA BEH IR
SSL Secure ASDM ~D## I SSL 2l L, ZeTh D
ZEERLET,
=3 ASA (TR E ST FEZ,

Connection to Device

Device List

ASDM % ASA & D8 % i IZHERE L. [Monitoring] <A >3 X O [Home] A > DF — 4 % #;
R ET, COXATRI Ry 7 AR AT —ZANRERENET, 307 4 Fal—
TarEERETLEA, ERELTWAM ASDM 13862 9 —o &, ZENKDL XD
Bz CETN, 20X T s Ry 7 AT 2 DB OEGITFRENET A,

[Device List] iX K v ¥ JAIREZRANA T, ~w X —IlHDHI3DORE U EXNENT Y
73 BHE, N UDORKEETITEIL, BEIFRER T e —T 4 VTN DT XA D
FEERE, FLREFA UEALDZENTEET, ZOXAS FA—4A, 2T 4 F2b—
Tay, F=A—U T BIOVATLAOEE a—TCHEATEXET, ZO1 UEFEHL
T, BT ANRAL AZHNBEZTZD, VAT AL TR A MNATUNREZ -0 T5Z LR TE
FIN, BEFEITFOLDOLE U A= 3D ASDM BZDT A ZATHEIEL TW\WA X%
N0 ET, A UEERICRRTHITIE, D EH200T A ANRY A MIERRINT
WAMERHY FT, TS, Y aryTHxA N, wAF arTxRA MBIV
AT AN AVTHXARNDONL—T v RE—=FBIXOMN T AT L b = R CEHTEET,

ASDM 5524 AL a—4—1v4—7z42 ||



| ST

T, UEFER L TRIOT N, AT

FIE

ASDM 5574 AL 1—H—(v8—Tx(Z |

THIE, ROFIEEFATLET,

ATV F1 [Add] 227V v 27 LTY A NMIBIOT A ZAEBIMLET,
[Add Device] ¥ A 7 VAR v 7 ANMFREINET,

ATV T2 TARARZFIZEITRAADIPT RLAZASL, [OK] 227V v 7 LET,
ATV T3 VAL BRIRLIT AL ZAZHIBRT 5I121E, [Delete] 27 V v 7 LET,
AT w74 [Connect] 7 V v 7 LTHIDOT A A28 L9,

[Enter Network Password] # 1 7 & 77K v 7 ANRFR S NE T,

ATV TS =P —FHLRXRAT—REHYBTHT 1 — /L RIZATIL, [Loginl 7 Vv LET,

H@ERE

%< D ASDM A 21T, ROFITRTREZ U NEENTWET, HIOEELZ%ETT 51

i, ETLOARS &Y v LET,

R S5EA

& ASDM TOEHHNAE A ASAICEE L., FET=
V74 X2l —a AT EALET,

Save FEFar 7 4 Xal—arDat—275y
Va AEVICEXIALET,

Reset IEHENRZIFE L T, ZEFAT, £7213 [Refresh]

L [Apply] /R t2IC 7V v 7 LR OFR ARG
HIZELET, [Reset] 27 U v 7 Liztk.
[Refresh] 227 V v 7 LT, BIEDF a7 4
Xal—a VOFRBPERINTNDZ &
EHERLE T,

Restore Default

BN EE 7 V7 LTT 74V MRIEID
E L/i‘a‘(}

Cancel EHENEEZWIEL T, BIOA TR £,

Enable FEHEIC DWW TR A B0 B O aHE 2 FoR
Liﬂ‘o

Close BWTWAE AT a s Ry 7 22 HCET,
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F—AHR—FD a—t+thv b .

RE ERBA

Clear 74—V KD OIEREHIRLET, £,
Frv IRy I AEFTIZLET,

Back BRI, NZRED £97,

Forward DA NI E L F T,

Help BR LA FEBFFAT TRy 7 A%
FRLET,

F—HhR—FDa—rhy bk
X —R—FEHEALTASDM 2—Y%— f L X —T =2 A% TS~ FTEET,

WDOFIZ, ASDM 2—H— f L Z—T = A 2D 3 DO EE/RFEEM 2 B8+ 5 7= DI A 7]
BRF—FR"—RFRya—rhy hOo—EE2RLET,

RI:AA D4V EIADF—FR—FKa—+Av b

ELF Windows/Linux Mac0S

[Home] A1 Ctrl+H Shift+Command+H
[Configuration] ™1 > Ctrl+G Shift+Command+G
[Monitoring] ™~ >/ Ctrl+M Shift+Command+M
Help F1 Command+?

Back Alt+/E%H] Command-+[
Forward Alt+4AH1 Command-+]
ROV T L va F5 Command+R

Cut Ctrl+X Command+X
Copy Ctrl+C Command+C
Paste Ctrl+V Command+V
a7 4 X2 b—3a o |Cul+S Command+S

17

Ry T vF A=ma— Shift+F10 —

vHhUHY v KL |AlttF4 Command+W

%)
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B =r—rova-rnur

ASDM 5574 AL 1—H—(v8—Tx(Z |

E GO Windows/Linux Mac0S
Find Ctrl+F Command+F
Exit Alt+F4 Command+Q

F—7NVEITT F A bk
DT

Ctrl_Shift % 7213 Ctrl+Shift+Tab

Ctril+Shift F7-1%
Ctrl+Shift+Tab

WIZERIZ, XA RO F S~ a AR —FR—Fva— My bo—E&RL

i@—o

R2RAVADF—KR—FK Ya—t+tAhy b

T+ —hZADBBE *—
WD 4 —L R -
A7 4 — R Shift+Tab
DT 4= R (F—FNNICT +—H A3 |Ctrl+Tab
oL %E)

BiD7 4=/ R (F—7 NANIZT7 4+ —H A3 | Shift+Ctrl+Tab
HH%E)

RDET (ZTNCT 4+ —HANDDLEHE) YEPN=)|
HIDSZ 7 (BTN T7 +—HAND DA FEREN
T—T NVHNDOERDE )V e
T—7 NVHNORIDOE IV Shift+Tab
WRDONA v (RO U RFRINTND |F6

=

RIDRA » (BEDOSA U RFREN TS | ShifttFoe

50

WDFEIZ, Log Viewer CIEHAIERF—R—F v a— bty ho—&EZ2RLET,

®3:0 Ea—70OF¥—HK—FKa—t+hyt

Bt Windows/Linux Mac0S
Real-Time Log Viewer ¢ —§fz | Ctrl+U Command+
1B L O

gy RNy 7y XLrnl) 7 |F5 Command+R
Lo
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asom <1 »omziss: [

k] Windows/Linux Mac0S

NES e 78y 7 7 DI Ctrl+Delete Command+Delete
R L7z = rYoa  |CultC Command+C

B —

a7 OIRAE Ctrl+S Command+S

FII Rl Ctrl+P Command+P
vHoXY 74 RUEHL |AlttF4 Command+W

%

WDOFRIZ, A=a—THH~OT 7R FEHAERSF—FR—Fa— iy bo—E2RLE
j‘o

R4 AZ2—EBRIZFTIVERTBEHOF—HR—F a—rhy bk

TIEARE Windows/Linux
A= a— N— Alt

WD A= 2— VEPNEI

HIDA =2 — FEREN
WDA=a—F T av FSEL
DA =a—F T ay ED
BRLIEA=2—F T g Enter

ASDM XA > DIEZREHE

—H8D ASDM A Zit, L DEREFOT—TIANEENTWET, HEOTZ ) %
IR L UOBRIHER L CRET A 7D, BED ASDM 21 iZid. b DA v
WNOA TVl FERRTE DMBEENEGENTWVET,

MR FATTHHBEIE. [Find] 74—V RIZ7 L—RX% AL, BEDXA L NOTXTDH
TALERBCTEET, 7L—XZZVUAN KR —RFED [+ BXO 2] 25052 LNT
ETET, T IO EDOTFEEHL, 21 o0XFE —ELET, [Find] 74—/ ROAIZ
HDERHETFREAZHEHALT, & (F) 72360 (F) o7 L—XOHBICBEI L £,
[Match Case] = v 7 Ry 7 A& AN 5 & AJI LTI RICTH L OV T IEfEIC—BT
Lo N ERBLET,

7= & %X, B*ton-L* E AJ1T 5L, RO—ENEINET,
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B vz ronzme

IL—IL 1) R

ATy I
ATv T2

ATvT3

ATy T4

ATy TH

ATvT6

ASDM 5574 AL 1—H—(v8—Tx(Z |

Boston-LA, Boston-Lisbon, Boston-London

Bo%?on & A1 T 5 &, RO—HNEINET,

Boston, Bolton

b DIRFR B EE

ACLX° ACE BLOZEDOMDON— TS ESERIA TOLEOBERNEENTNDHTD,
NV EFIRT DAEE DA ORRERERE TlX, DA  ORBREEEL Y b IR EK - T2
REFTCTEET, ZZE, 778A L—)b, =X R Y I — )L—/L ACL Manager,
ACL V=1V % —BFRRTHEDOMDONA ) BIRNAT L — b EENET,

= U A MNTEZZRAET D121, ROFIRZETLET,

FIE

[Find] 227 U v 27 LE7,
[Filter] 7 4 —/V R T, Ry X7 VR RNLIROLTT > a O TnERINL 7,

BRATREZRE AL, V= XA T Ko TELRY , IR L TWET, o7 4—1
N2 3 D MR B 2B T 55 A 13, [Query] Z 3R L £77,

[Query] IR L7z no 2381, 2BHED T 4 —A KT, KRy 7 X o2 U R RPERON
TNILOA T a BB LET,

o [is] : BRBEXFINCHRT 2 —HERELET, ZNEFEZ Y47y a2 TT,

* [contains] : FRERLFHNDO— B ETNT BB E B LLEDONL— /I T 5 —BAERELET,
3FEEHDOT 4 — IV RIZ, MBTDHILFINEATILET, .27V FT5L VRAMPLAT
YVl hEBRTEET, 72U EMHL TWAEE1X, [Define Query] #7 U v LET,

IP7 RLUAZMBTH5AF. ASDMIZ Lo TERENT=AT V27 bERIZIIN—TTH
LRV, Xy NI =0 F T2 FEFIIITA—THNOT RLRAIZ—HTHLOEGETxE
T, DF V., FV—T4IIDM INLINE THEE Y £7, BBHEIL, =2—V—»2MER LA
7 NNOIPT RLAZKMERTEEHA,

&2 FITT HITIE, [Filter] 227V v 27 LET,

Ea—NEHISN, BT V=N OBEBPFERINET, L—AEFIE L—n U A FADIE
KNLIEZ MR TE D & D ICHERF SNV E T,

[Clear] 7 U v 73 5&, 74 NVEZDHIRSI, VA MNERHBERRINET,
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ATy 717

mEz s y—> u—4 yi—roant [

FET LD, READOXxEZ 27U vy 7 LTHRERay he—Lz L £,

HaRRA V) —2 )—5 H/R— FOBEHIE

ATy I

ATy T2
ATvT3
ATy T4

774V FTIE, Tab F—ZH LT VNEBEIT S L X2, TV RIS 7 OBE)E
MOBRANENET, JAWSDO R SR —E DA UV —2 U —=FT2F013, 74— ADH DA
T2y MEHELRY ET, EEAZ V=2 V=T FR— N EA XTI MCT DL, T
LRI Y T EBEISEDL LN TEET,

PERAZ ) =2 J—=F PR— F A X—=TMZT HITIE, ROFIEZFETLET,

FIE

[Tools] > [Preferences] DIEIZER L F 9,

[Preferences] ¥ A4 7 2 7R v 7 ANFRSNET,

[General] % 77 @ [Enable screen reader support] = v 7 R 7 A=A 2 LET,
[OK1 %27 U w7 LET,

A V=2 V=F BR—=b&T 7T 47123 HI21E, ASDM % FiEEh L 7,

BIER ALY —

a7 4FXal—varybta—RBIOE=F—) V Ea—DFEr—var XS INEF
NH—WDO7 +NZI2iE, BEMITONT-ar 74 Fal—ary XM URE=L—) )
RAVMHY FRHAL, TNHOT7HNFE, BHETLay 74 Fal—var FRITOE=
B =N T BRAY ZHBT LD LET, 207+ F 520 ) vy 7358 Ao
[Navigation] A NZHTHEDO U A "RERSINET, YTHBOLRTZZ Vv 7 T5 L%
DHAICBETEET,

[Home] R4 > (VT I E—FEQAVTEREN)

ASDM @ [Home] =4 > Tix, ASA IZRT 2 EE/REREFRTXEJ, [Home] 21 DA
T2 AERITI0MHBTER SN E T, 2D 1 ITIT#% ., [Device Dashboard] & [Firewall
Dashboard] ™ 2 >D % 7135 0 £,

IPSEYV =2 —/b, CXEYa2—/L, ASAFirepower £V 2 — LR EDN— Ry =T EFT Y7 b
VT BV 2= BTN, AL VA R INTWAEEIEL, TRHEHOX 7RERRSNE
D
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. [Device Dashhoard] % 7

[Device Dashhoard] &2 7

[Device Dashboard] # 7 Clx, f v X —T =2 ADAT—H A EITHOR—=T g TA4F
VANEWR, XTI < AR Y ASA OEELEREY —H CHER TE £,

WODIKZ, [Device Dashboard] % 7 D EHZZ /R LET,

2: [Device Dashboard] 2 7'

Tl ASEM T 1 Foe ASS - INAR IR F

- oo
%‘f}mﬂnn:m |5 venodirg e e tetmih | bk [ Farawd | S iwip T Tootls

cin
ARM sl il

A W Fwbes F Cavres -
[ L = : :

r
B zpem Bdoan 0
B ozran Wdzar 0
B ap [~ WTE

Tir . BArs fememion

_-m T tieerse  s5a Chuer

L NTERTEEY
CERUF N E
= A 115D

Hwar Hats: [FTF

ERNE TILES L PRI Tesdes e 13d LhAadin 4
FRIT R ILEE] S W T.105113 Devie - A& FEITONEFOLS
LRUENIEATS Fleswall badr Feaumed vomen Haze Snpe

F i Ererarmenl Males: T ow Telal Frake 2249k ME
2 |0da 11503

R e Salbr 07 rearack e e nzan and sLimen Khze

L LA LR E )
W i ,._.: S @—.‘ AT Saa o Tralli Sadars ‘_®
Lo Wie b Ciealkes SEUWR 0 deplomaed Cienrop DRL Carrectiars Per Saecrd s

CNUE TR

v ] @—bm&wwm i
B o e i - il

AU s el M U] DA W Gaege Laelemns Sdab

L LR N EhN BT

raary L s (UK

Y B i " LAk} T [T

Ao e e EL.CHED M7 0 Toral 0

: :I-f::t.i-“ ére] Araragnrrzald st bl Usos e H : :I
CR SRR L | 000 B
B Tiasanmal

Ao

& ITEIES (L] : x
LR EENE N IR i i ; * FES e

B ivrrasna LET - Bt ] e (15 [ ETTILCT T JUTr e

o | Leris i5 Bvan
) [OLTRaTe

e T a3

eEa] ] i AT S Baa
o e Tew  Gdall Boaoen i me Rk B Tk ke

L

3

-
AT I -
B ITRA5AM.LIT 2
RIS T RAY] L
ERECESE T b
L REFRENCIRIT| -
CREEEEEE TR R

TR LS 2ies
a1
-

JEE520 ma icen

LarmmLikaTi bnar 2
A czrraciban LSS lzr

18,0 LIEGLS 1N 1938 L4 32, LS8 LLAZ 43 Dwry TCP
127004 16 1935 104 22, M5 LLEE 281 Taadzar

Leane i

JFmEa25

oo il sunurssiais, dxn i o B B WAL s L LS P

AR

GUI & Bl

1 [Device Information] X1 > (23 ~X—)

2 [Interface Status] ~~ > (24 ~—72)

3 [VPN Sessions] <A1 > (24 ~<—7)

4 [Traffic Status] ~<1 > (25 ~~—)

5 [System Resources Status] ~<1 (25 ~—7)

6 [Traffic Status] ~<1 > (25 ~<—)

Device List (15 ~X—7)
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[Device Information] XA > .

GUI Z=x% B

— [Latest ASDM Syslog Messages] =<1 > (25
)

[Device Information] X1 >
[Device Information] 2 > {Z1X, [General] % 7 & [License] ¥ 7 &9 T /34 AfEHEFKRT D
200X TRHY T, [General] ¥ 7 Tld, v AT L ~JLAD—H ThH>5 [Environment Status]
REANT 7 8ATEET,
[General] 2 0
DX TITIE, ASA T DROEAEHRPETENET,
* [Host name] : /34 ADKA M EF R LET,
« [ASAversion] : T/NA A ETEITESNTWVWDHASAY 7 b =T DONR—Va &R LET,

* [ASDM version] : 7 /31 A ETHFITENTNDHASDM Y 7 b7 =7 DNN—T 3 U EFRL
i‘j‘o

« [Firewall mode] : /3% ANFEITENTWDE T 7 A T U4 —/L T— REFRLET,
« [Total flash] : B/EMH STV 5 RAM OAF2F R L ET,

* [ASAClusterRole] : 7 7 A& U U I RHENDLGEIT, ZOEBEDOR—)L (v A Z—F 7%
A I/_j‘) %%ZT—\A L/iﬁ‘o

s [Device uptime] : Hf&IZY 7 N =T %7 v 7 B—RKLTHhH, T/ ABREELTND
R AR L ET,

s [Context mode] : T /NA AMFETINTWNHIALTHFA N E—RERRLET,
* [Total Memory] : ASA |ZA > A h—/L &} T\ 5 DRAM #H£ R LET,

« [Environment status] : A7 A~V A% FKx L E T, [General] # 7 @ [Environment Status]
EWVWII TN DENCH DT T AFE () 27 Uy LT, ~"—RNY =T HEHERE R
RLET, RESNTWOEREEROMHR., 77 v EEREY 2 — VOEWEAT — X X
DB, 3B X OVCPU DIRE & o A7 LD E AR OB A FITTE ET,

—fi%Z, [EnvironmentStatus] R % > TV AT LA ~NLVAN—HThrY £, VAT ALAHRND
FoH—HRBOTRTON— R T =7 a2 R—FR FNIEE RGN TEMEL TV 58
G TTAGE (H) RE I [OK] Bk CERRrENET, —FH, N—KU=T VAT
LD R—= 2 FH 1 D THIEFERHBSNTEEL TV LGEIE. 77 Ris (+)
REPDIREDINZ IS TI VT 4 ANV AT —HA%R L, N—RU =7 T UKR—F
MZB LTI <IZHANBETHD Z L E2RLET,

FED/NN—RY =7 OFGEHERIZBET 23EMICOWTIX, 2T N, 2D [N—F T =7
TAR] 22 LTS,
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. [License] % 7

\}

GE) HEHVIU—ADASAILT v 77 L—RTHIZEAEYBARELTODHEEIE, [Memory
Insufficient Warning] %A 7 0 7R v 7 ANERINE T, TOXA T 0T Ry 7 AR REN
HIERICHES T, PAR—=FENTWA FETASA B L ONASDM Zifffe: L CEA L £9, [OK]
7 Vw7 LT, ZOXATalRy 7 A% LET,

[License] # 0
ZOETINE, TA B AKREOY Ty RRRRINET, R T A B ABRORRE
XL WT 7T 4 =23 v F—D AN EIT 5121, [More Licenses] %7 U v 7 LE 7,
[Configuration] > [Device Management] > [Licensing] > [Activation Key] XA V' NE /RSN E T,
[Cluster] 2 T

IDETINE, VITAZDA L E—T 2 A AE— RBIWNI TAZDAT —ZANKRRINE
j—O

Device Information

General = License

Cluster Interface Mode: Spanned EtherChannel

Cluster is not enabled.

Details

[Virtual Resources] 2 7 (ASAv)
ZOXTIE, ASAICE > THERAEINTHWAIREY VY —2&2FRLET, vCPU O, RAM,
ASA DT bV a = T OBRENESENET,
[Interface Status] N1 >
TDONRALNE, BAVE—T 2 ADAT—HAANFRENE T, A1V F—T oA ZADIT%
BIRT L, ADBIOH I AL—T b2 Kbps L TT —7 VD FIZFERSNET,
[VPN Sessions] X1 >
ZDORAUNTIE, VPN b )y AT — X ANFRENET, [Details] 227V v 735 L,
[Monitoring] > [VPN] > [VPN Statistics] > [Sessions] XA I E L £7,
[Failover Status] ~1 >
O NTIE, TV F— N AT F ANRFIREINET,

[Configure] &2~ Y =2 L C, High Availability and Scalability Wizard Z &8 L £3, Z D7 1 HF—
REFZETTDHE, 7=2—NAA—N_"—ar 7 s Fal—a AT —HA ([Active/Active] 7=
IZ [Active/Standby]) NFERINET,
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[System Resources Status] X > .

T )L A R RERE STV D AT, [Details] 227 U~ 7§25 & [Monitoring] > [Properties]
> [Failover] > [Status] ~A1 23 & £,

[System Resources Status] X1 >
ZDORA NI, CPUB IO AE Y O RBUCET DREHER D Z R SN E T,

[Traffic Status] N1 >
TN UNE, A E—T = A ARG L, RbEVNVEX 2V T 4 A U F—T =
AADKT T 49T AN—T > DT T IRNFREINET,
A T4 X2l =gl X2 T 4 LR EBENA L F—T o AREEESENTE
D, ZONTNNHDOLFIN loutside] THDIGH, TDA L F—T A ANNT T 4T A
N—T2 "OT T 7R ENET, ZRLUNOEA, ASDMiZtX=VU T 4 LUV
BN H =T oA ADT N7 7 Xy MED U A NNOIRPIDOA X —T = A Az iR L E

TO

[Latest ASDM Syslog Messages] X1 >

ZDNA NTIE, ASADERR LTERFT DOV AT A A vE—U RN 100 lE TRRINET, B
XTINT 4 =T NI o T DAL, [Enable Logging]l 27 U v 7 LTA F—7/MZ L

£,
WDIKZ, [Latest ASDM Syslog Messages] A > DEFREZ/RLET,

3: [Latest ASDM Syslog Messages] R A >

9

Latest ASDM Syslog Messages
Severty | Dabe Time SwskgID | Source IP Source Dastnabion P Dastind Dascriphion

N2021  egdiidsalf.. O Faz::1 ¢ Taardown [CMP connaction for Faddr feat:

£

AR

GUI EX* S5ER

1 RA DOV A REEFTHITE, Ta4NA5
EFEFIITFICR T v LET,

2 NS ERBBALET, A BT 7LD
A XZRTIZE, ZEQEAROT A 2
7 Vw7 LET,
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. [Firewall Dashboard] % 7'

ASDM 5574 AL 1—H—(v8—Tx(Z |

GUIEH

B

Ta—T 4T XA UEERLET, XA
ERyX U TTHIE, RyFdFodLi=Ra
oTAarEI Y7 LET,

HE)FERRE A X—T N ETET =T
WZLET, HEPERRDA R—7 VRGE1E
72 T HRIZ & % [Latest ASDM Syslog Messages]
RELD =Y NVEBET DL, ~AM
MFERINET, =Y NVESA UPBREET
& A IERIRITIR D £,

RAEHALET, A U 2RKTTHITIE
[View Latest ASDM Syslog Messages] % 3R L
EJr RN

FHCH 8D T A a7 Vw735 L,
syslog 2 v &=V DERROEFH &HeAT LET,

FZHAIFWNT A arz2r ) v i35k,
syslog X v E—Y DFRROFFZ4FIE L £,

FHZHDTANE TAarm ) v I35
& . [Logging Filters] XA » 3B & 97,

e AR NELZ Y 27 LT [ClearContent] #3#IR$ 2 & | BIEDO A v —VEHEELET,

e ARV a7 Y w7 LC[SaveContent] 27 U v 7§25 L, BIEDA v —T%PC ED

T AMVREFELET,

AR a7 Y v 7 LT [Copy] ZIRT 5 & BUEOWAEZaE—LET,
e A XU NEHZ Y w7 LT [Color Settings] Z1&IR 5 & BHREIZESUNT syslog A >

t—roE RO LHIROEERE LET,

[Firewall Dashhoard] % 7

[Firewall Dashboard] % 7 Cl&, ASAZ T 5 N7 7 ¢ v 7 IZHT 2 EERIERZHERTE E
T, ZOX v var—KRiE, Yo/ raryFANE—REREF~YALF a2 THFANE-F
DELLTHAINIZEV R EF, v LT 2T H A M F— RTiE, [Firewall Dashboard]

3B THRAMNICRRTEET,

ROKIZ, [Firewall Dashboard] % 7 D EFEDO—{ %~ LE T,
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[Traffic Overview] XA > .

4: [Firewall Dashboard] 2 7

# Cizem A%DM 6.3 for ASA - 10 B8 54 BE

| JIIL..‘.'....-......“ e — = TS
2
| i | W Rl ey § sy ep i 1
o, l-_qi .I
R .. !I .IH" .I._ql. _H_ .Il
1 e Ewwd b b o
= : T T T o — -.
r.:fjf;:ﬂ!u-...f_ el T sl s Yo om0 L8 ol | a1 Uy B
L r 1| | Il Fnmdon (L
| FEN S £y oma f
-_‘- lh.—l. 'l-ﬂ._‘. 'I-‘} wl
e A T e o) B
- £ = ] N i e lw.llr;j;
FL5I
GUI % EHEA
1 [Traffic Overview] <A1 > (27 _X—7)
2 [Top 10 Access Rules] <1 > (28 ~=X—)
3 [Top Usage Status] ~~A > (28 ~X—72)
(FR72 L) [Top Ten Protected Servers Under SYN Attack] <
A (29 —Y)
(FT7e L) [Top 200 Hosts] XA > (29 ~=X—)
(FR72 L) [Top Botnet Traffic Filter Hits] <31 > (29 ~X—
)

[Traffic Overview] XA >

T 74N RTIEE, A RX—TNAVTT, EAREBEMRNET +8—T 0T ([TZ7A4T7 04—
NOREHNA R #BM) | Z OFFEIZIT [Enable] R % 23R S £, [Enable] R ¥ > %
AL CEAGEREEZT E—T M TEET, ETRORERICIT, RHEAOKOE
WREENET,
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. [Top 10 Access Rules] X1 >

o PEeEE & NAT Z2#a35,

e T RBAVANMIIDBESERBIONT YV r—va v A AT g il TRaey
SINT=RT y NEURD,

s Rey T Ny MR, ZHUE, A%y VEEBEO—E LTRESh DB L, AEd
v iart LTHHEINAES (TCPSYN KERLF— 472 L UDP v a v s
BHLZSEERE) B £,

[Top 10 Access Rules] X1 >

FI7 3 NTlE, A F—TNTT, T7EBRAL—LOBBEBREGEERET 42— T 5
EAAT77AT O —NVORENTA R 22H) | Z OEKLICIEL [Enable] R U BNERENE
3, [Enable] R¥ L 2ERLTT 7R L— L OFEHEREECTEET,

TN Ea—TlE, VAMPOA—LERIRLTEZ VY7 L, Ry 7T v A=a—IH
H ® [ShowRule] # R/ R CTE £¥, ZOHHEZEIN L T [Access Rules] 7— 7 /LI EH L, 7—
TARNICHHZDON— NV ERIRLET,

[Top Usage Status] N1 >
TI7HINVERTIHE, TAE=TATT, ZOXLUNZE, RO 4OOETRH £7,
* [Top 10 Services] : & B HH— B 2
* [Top 10 Sources] : & iR HH— B A
* [Top 10 Destinations] : i H - — & &

«[Topl0Users] : TAT T AT A4 77AT U4 —/bH—E2R

B 3 >DH 7 ([Top 10 Services]. [Top 10 Sources]. 33 & OF [Top 10 Destinations]) T, #&
B — B AT o FGEHERA R L E T, £F 7L, ENEFhOEBREY—Ev 2%
A X =T MZT S [Enable] RZ 3DV ET, [TZ7 AT U —NOREHTA R IZ9E-> T,
IRHEAMITEET,

[Top 10 Services Enable] R¥ i35 &, R— b & 7va b a Ol FOMHERI A F—
T FT (EBLLEFHICA F—TNMITHHENRNH Y £97) , [Top 10 Sources] R #
> ¥ L O [Top 10 Destinations Enable] 78 % 2325 & A A N OFFHERDA K —T T

RV ET, FARN GEEILB L% O AEARAT —# AFEHER, BLOKR—KETnm
P A VRERRINET,

AFZHDOH T [Top10Users] Tk, 7AT T AT 4 77AT 74—/ H—ERIZHT LHET
WA LES, TAT T 474 774 T V4= P—ERATRH, 2—H—D7 AT~
TATAZESLT 78R arba—z R LET, EEILIP T RLATER 22— —
Ll a— P TN —T RSN TT VA= e EXa VT 4 R — R ETXET,
ASA L, IP b a—H—D~v o BT T—HRXR=R T 7 ALT, 2OV —b Rz LE
7T

[Top 10 Users] Z 71X, IROWT NN ERE LTEHEDHR, T—FERRLET,
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[Top Ten Protected Servers Under SYN Attack] ~ - > .

« Identity Firewall — B2 =327 ¢ ¥ 2 L'—1 =3 > : Microsoft Active Directory 35 &2 T8 Cisco
Active Directory (AD) =— Y = DB R—R> hOREZ G HE T, Identity Firewall
P —E AL, user-identity enable =~ K (57 4/L N TH%)) I X O user-accounting
statistics 7~ > FE&RKE L THIMEE L E T,

¢ VPN 22— W —D3REE, BATEIZT I T T 4 2 7 %4T 5 72912 RADIUS H— — % {5
HATAHVPNaL 7 4 Fal— g,

B L7247 3 G U, [Top 10 Users] Z 712, BN 10 22— — D5 L7z EPS /X7
b\%ﬁbkmﬁﬂ&yk\kiU%méhtﬁg R DMEHE AR R INE T,
(domainwuser_name & L TR INLD) Fax—PF—ICBAL T, 20X 7L, 20— —0D

FHJEPS Xy b BUEDEPS X7 v b, MU — BROEFA X MBIERENET,

ER O JORREHERAEANCT D L. AT HHEHERDO X A TIE LT, ASAD/RT —< A
DEBLZTET, A NOHEFHEREA X —TMZTDH L, N7 —< L ATKRE REEN
HVET, T T4 v ODARMBENGEEIL. 20X A T OMEHERIZ RN A R—T I
THZEERMNL TSI, 272 L, A— bOFHEREZA X—T7 /L TH, FhiF
BIIbHD FH A,

[Top Ten Protected Servers Under SYN Attack] N1 >

TI7HINVRTE, TA4E—=T AT, ZOMERICHFKREIIN TV D [Enable] R ¥ > & H LT,
COMREEAMMCTEET, FF. 77 AT U —EETA R 1> TEIZT D Z
EHTEET, WBEZ RSN BAZ 10 = —DHFHERPERINET,

VLB L — FOGE, ASAILL— MR (7744 ME30%9) (S L T30 T &IicT —4
YTV T UET,

BHOKBE NN DHEE1X, T<various>] DRICHREDOHBEEDIPT RLANFKRINET,

[Detail] 27 UV » 7 LT, 10 BDOH—_"—721F T, TXTOH— 13— (FK1000E) O
FHESAEFORLET, BEY TV T T— 5%ﬁﬁﬁéyk%fﬁi¢AﬁAiV—kﬁ
FEOMICH DS Z 60 RV 7 ) 7T 5DT, T 740 hO305ME T, 6072 L1k
FHERBANE SN ET,

[Top 200 Hosts] N1 >

T 7 ANV ETIE, T48—7 T, ASAZIT L CEEH D E72200 DR A N &R LET,
RARDOFKT B YT, TXF®ETFVXk RA M & o TR SN Bt OB &
Fh, 2O RV ROBTECT v I TS NET, TOERREART—TNIZT HITIE
hpm topnenable =~ > KZ A L £,

[Top Botnet Traffic Filter Hits] X1 >

T74NETIE, T4—T7ATT, ZOMEKIZIE, Ry hRxy N NI T4 v T TaNEE
RETHEODO) I NEENTHET, L I0HORy bty b ¥ A b, R—F, BIOY
PR A RO LFR— NI, T—X2DAF v 7 ay MR HEHEROIERELIFED F
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. [Cluster Dashhoard] % J

M0 EAIL =B LRWEAENHV £, IPT RLA&ZL27 U v 732 L ., whois ¥ —/L AN
BLTHRY bRy b YA FOFEMAFRSNETS,

FEICOWTIE, Ry by FRETA F] 2ZRLTIZE0,

[Cluster Dashboard] & 7
ASA 7 T ALY v T A F—T LT, AL — 2=y MEEL TV BEAIE, [Cluster
Dashboard] # 71227 FAZ DAL N— T L) Y —AEHEOMENERINET,

08 ) Home

e el Dasiooad,

Resource Utilization
Device Mame ‘W“Q‘!M&Iﬂ IP Address Role Version ‘ Uptime Enviromnment Status |Heallh Status CFU | Usad Memory
clsl 172.23.204.243 MASTER 100.8(0.94) 2d 15h 56m 495 | 9 =]
2001:b0b:6500::3 7L | 7 unknown [ 1% BE294 MB

Average CPU Usage (percent)
- 2]

X ~Cluster Overall
2

1% 50 [
40 1

" v 0 -

— 1] - - - 0807 0808 0809 08: 10 08:11
JE11.0: vg.o7 0508 02:09 ge10 W UDP. 0 EETCP. 0 M Total: 0

Connections Per Second Throughput Load Balancing P_]

Overall Memory Usage (MB)
T i

450

400

~Per-Member Total
2

0807 0808 0809 08 10 0811
W clsl: 0

18:11:0: o&-07 08:08 0&:09 0&:10

B[N

+ [Cluster Members] : 7 7 A X ZAEKRT D A L /X—DAHT & FEARFR EFEIP 7 KL A,
NRePay, I7TALRDA—LRE) BERALSA—DNLVART—H A (BBEAT —
HA L NVART—H A BILONY V=R 22X RLET,
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[Cluster Firewall Dashboard] % ' .

B ~1FarsyXxAhE—FRTIE, BHa TR M
ASDM Z#&#i L, IO TF A MIAERLTH,
UARRRENTWLEHRIPT RLAFBEOa T
X2 FNOEHIPT FLRACEREEINEE A, ASDMN
BEHS SN TWA AL L VT AEZDIPT RL AR5
DEHa T A NOEHIPT RL AL, Sl&FE#E
s U £97,

* [System Resource Status] : 7 7 AZ R{RD Y VvV —2ffiffj= (CPUBLIUAEY) & 7
TAvIDTTT7 (VTAZEERBIOT A RATE) 2R LET,

s [Traffic Status] : &% 7ZIZRD T Z7 70360 £,
* [Connections Per Second] % 7
[Cluster Overal] : 7 7 A Z RO B OB TR INET,
[Per-Member Total] : 45 A >/ N— DR BL OV EHGRB A TR S E T,
s [Throughput] % 7
[Cluster Overall] : 27 7 A X RRORH I AN—T" > RBERRINET,

[Per-Member Throughput] : A >/ X—DA/L—"T" kM, AL NN—=TLIZ 1173 2FR
SNET,

* [Load Balancing] % 7

[Per-Member Percentage of Total Traffic] : A > N—NZ(E LTI TAY N T T 4w 7
DFENG, AN=T LR RINET,

[Per-Member Locally Processed Traffic] : @ — D /VIZALBE STz N T 7 4 v 7 OFEIE M,
AUN=TEILFRSNET,

* [Control Link Usage] % 7

[Per-Member Receival Capacity Utilization] : Z5E A EOMEHFEN, A =T LITRR

SNET,
[Per-Member Transmittal Capacity Utilization] : SZ{E R EDOFE N, A =T L|IFK
IRENET,

[Cluster Firewall Dashboard] % 7

[Cluster Firewall Dashboard] % 7' |Z1%, [Firewall Dashboard] |2/~ S D IER E KD N7 7 1 >
7 OEL L TtopN) FEHERDBFRINE TN, 7 7 AXRIRICOIEDEHIER RSN E
A,
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. [Content Security] 2 '

Connection Statistics

Interval: Last 1 hour =  Based on: Packet HitsDisplay: Tab
4

3

2

The Top 10 Access Rules feature is disabled in the Security Appli
1 Please click the button to enable it.

|- Enable |

- ' i -
0&:.07 03,08 0809 DE:1D 0&:11

M Connections: 1 M NAT Xlates: 0
Dropped Packets Rate

The Dropped Packets Rate feature is disabled
in the Security Appliance.
Please click the button to enable it.

Top 10 Services i Top 10 Sources >

Interval: Last 1 hour - Based on: Packet Hits 5 [

Possible Scan and 5YN Attack Rates

The Possible Scan and SYN Attack Rates
feature is disabled in the Security Appliance.
Please click the button to enable it.

The Top 10 Services feature is disabled in the Securi
Please click the button to enable it.

| Enable_| ofnhle,

[Content Security] & 7

[Content Security] & 7 Cl%, CSC (Content Security and Control) SSM (Z B3 % B 272 1t % fife
RTEET, T, E, CSCSSMTEMEL TWNDHCSCY 7 M7 =7 R ASAIZA A b—
NENTVDBEDHFRENET,

N

(G¥)  [Configuration] > [Trend Micro Content Security] > [CSC Setup] % %R L T CSC Setup Wizard % 52
T LTWARWE | [Home] > [Content Security] D FIZ&H DA NIT 7 BATEEHA, f{DV
\CHEAT TRy 7 ANFEREN., ZOHFT S CSCSaupWizard [ZEHET 7 B ATE £,

WD, [Content Security] ¥ 7 DEF &~ L £9,
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[Content Security] 2 7' .

5: [Content Security] 7 7

# Cisco ASDM 6.3 for ASA - 10.86.94.88 LEx
File Miew Took Wipards Window Help i NI
@:[%mgm (e Qs o 7 s i cisco
Noma s a — o
F "|_u""'_'|.'£_—||.' I |__.- "-T__am:
@—-"L?: I T e—r— EL ———— I +—@
el Barie Liceree Thevst Fpes Tasds Lt 7 s Lyt 00 s
CAsieing, ArtSprpaars, Fle Bladirg)
Mgre: [F: Lk Uipclain:
Fpepn Pl aares:
Doy B, - Licarsad Meslas:
®_*ﬁrﬂv—ﬂmtﬁ Shakas Emad 5 +—®
™ B: Phoaris rasd . i sl
(L -. R S5 Sy L3S [V . | ] -;'H'P Tm:-
. Phoaen re. . y
s | | * B ne = 1 ] . xR
O3 '
T Snroe  ThepstFlter SubosrtyFe UL P e Saerucies o, e B rton [
= 3
e ——r— o L] mg Emmn:nmmn
JFL451
GUI Ex% EREA
1 [CSC SSM Information] ~5A >,
2 [Threat Summary] X >, CSC SSM {Z & ¥ f&
HENZBROENT — 2 FRLET, U
ANAL AN T =T TANEY T
X7 vy 7 S URL, 780y 7 e AN
A, Tay 7 ENTET 7 A, BERIEY—
BRI ENRHY ET,
3 [System Resources Status] <1 >,
4 [Email Scan] <A >, 77 7121, 10[HET
T A BRRSNET,
5 [Latest CSC Security Events] <1 >,

ASDM 5574 AL 21— — A3 —T (4 X .



ASDM 5574 AL A—H— (28 —Tz4R |
. [Intrusion Prevention] 2 7'

[Intrusion Prevention] 2 J
[Intrusion Prevention] % 7 CliX, IPSIZBAT A EHEREREZMB TEET, ZDF 7L, ASAIC
IPSEV 2 —NRBA VA= LSRN TWEIHRBITOHRRRSNET,
IPS &Y 2 —/WZH T 51213, ROFIEEZFATLET,
1. [Intrusion Prevention] ¥ 7% 7 U v 7 LE7,
[Connecting to IPS] A 7 0 V7R v 7 ANF/RINET,
Connecting ta IPS...

ASDM will make a new connection to the SSP=IPS module in this ASA system.
ASDM makes a separate connection to the IP address of the management port
on the 55P-1P5 module.

55P-1PS Management IP Address: 10.89.147.143 Port: 443
Username:
Password:

| Sawve SSP-IPS login information on loecal host.

*Password cache is encrypted. Use File = Clear Password cache menu to clear it.

o “ - “
Help ) (_ Cancel ) ( Continue )

255100

2. P77 RLA, R—}F, 22—V -4, BIOXRU—-FE2AHNLET, 74NV DIPT
KL &R LA — FE192.168.1.2:443 T4, T 74V hOa—P—Z B LOIZ2T— NiT,
cisco & cisco T,

3. v A UERE R — IV PCITRIFT HIZIE, [Save IPS login information on local host] F =
IRy I A F AT LET,

4. [Continue] #2 V v 7 LET,

RABEICEE T 258>\ TiX, TIPS 7 A v 27 AZ— K A R 2L T EI0,
W ODIXZ, [Intrusion Prevention] # 7|2 & % [Health Dashboard] # 7 D% % /R L £ 7,

B ASMSS T4 AL aA—H—A28—T(R
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asacxstatus] 2 7 [

6 : [Intrusion Prevention] 2 7 (Health Dashboard)

=T ] R

i | an

J cisee
L [ .. LY oo o | [ (il i | st o | “
¢ T e— —¥ e
T A O
i e T R T =
o L e 7\
i = T Sibel Lrord 400 1) R Pebraally I| |
1 (=BT
| il
e L
ot B
izt et byl
| i e dprie Bl Fid Therlied
i I':qm.mmmml.m:
Sopherd v e 13, B0 | o SO
e Jpoits S Find Thanciond
LB ﬁ
e EHE I —
FL51
GUI Ex% HoL:L
1 [Sensor Information] = >,
2 [Sensor Health] ~= >,
3 [CPU, Memory, and Load] ~1 >,
4 [Interface Status] <A >,
5 [Licensing] ™A1 >,

[ASA CX Status] % 7

[ASA CX Status] % 71Z1%, ASACX Y o — VAT HEERFERNFRINET, Z0OXT
1T, ASAIZASACX EV 2 — LB, VA =V ENTWBHRICOAERINET,
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ASDM 5574 AL A—H— (28 —Tz4R |

e
s sicelisbboitt ™ fusilRasiaaiy ~ s xesrans
|,
ﬂﬁ Device Information
Model: ASASSB5-55P-CX10
Hardware Version: 1.3
Serial Number: JAF1543CGRE
Firmware Version: 2.0(13)0

Software Version: 0.6.1
MAC Address Range: 70ca.9bf0.1cad to 70ca.9bf0.1cab

Last updated: 10:56:39 AM m Interface Status

Application Name:
Application Status:

Application Status Description:

Application Version:
Data plane Status:
Status:

Last updated: 10:56:39 AM
ASA CX Security Module
up
Normal Operation
0.6.1
up
up

H[EET

Connect to the ASA CX application:

https://10.89.147.153:443

[ASA Firepower Status] % 7

[ASA Firepower Status] # 7'(2i%, ZOEY 2 —/LICETHERAETRENE T, ZOFRIC
I, BTN, VUTNANEES, YT U T RXR=U g R0V a—NERE, TV r—
varg, TV r—vary AT —HA, T—H TL—r AT —H R BERORT—H AT}
EDETVa— )V AT —FZANEENET, £ =—/L FireSIGHT Management Center {28k
ENTWLEARIE, Vo2& 7Yy 7 LTT 7 r—yva &, SR oeEy 2 —b
DOEREEITHIZENTEET,

Z DX TV, ASA Firepower ¥ 2 — VN T N, ZTA VA =L ST DHEEITOHER
EhEd,

FireSIGHT Management Center Cli72 < ASDM % {# f] L T ASA Firepower ¥ = — /L ZEF B L
TWAELEIE, BoX TRFRSNET,

 [ASA Firepower Dashboard] : % v ¥ = h— RIZiX, Y 2— /L TETHOY 7 vy =7,
"]GDT7 v 7T —h, T4 T VAT LAOAR, T4 A7 DML AT LK
M, BLXOA v F—T 2 ADAT —Z AZONTOMBEFERPIBRENET,

« [ASA FirepowerReporting] : LA — MERO~R—121E, Web h7 2V | 22— — %[5

Jo. BV a—VEBUTCI I 74 v I BEEINDIFHLERE, SEIFEREY 2 —1ORG
W LT AL 10D v 3o — RBNRENET,

[Home] N1 > (XA T L)

ASDM ¥ 2T A D [Home] A > Tld., ASAICBTAEER AT — X A EFREFRTE £,
ASDM ¥ 27 LD [Home] <A NNIFERSNDFHEMOIE L A L1, ASDM Ot dI5HTC 6 2
TEETH, ZOA U TILASADEMERELZ —H TR TE£7., v A7 LD [Home] <A
VDOAT—H AERIT 10 DEECTER S E T,

B ASMSS T4 AL aA—H—A28—T(R
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Homel <1 > (v274) [

WORNZ, AT LD [Home] A » DOEFEERLET,

7: AT LD [Home] XA >

® Cisco ASDM 6.3 for ASA | 171.23.204.65 | System

b L Look Wigrcs Window | Ciip il i
4 contpraton [ ] Mot | lown (Bmabh bk 7 l cisco
Dewice Lint @9 % |Mome | - o
el £ e Innelace S stus Conmectisirs SAatus
i pmm.u.au.u Testace Coramanr [ L e r— ﬁ@
= l cmts ety e || | Py
®—)‘ ki ol 0 n
e = ik 4|
TR EE A GigubErEamatlf .Y porbed? s
L NS LR CrabEftarall 4 cobad? nla ;
EREEE T i 5 -
R ey e
= s Hugmarice s ]
o 0T — i L5 LB M (L5 )
EREE T
ERE -
ERIT TR
= 1035224 e i d—@
Doagley: P " b Farorp L Bribin v (R0
B e 0} 2080 06
1 s ) P e
i . e
= = g
= Fetew wpdrrns = ag E.‘a—*mamm H
@
FLE5I
GUI EX% £ EA
1 VAT LE AT XA NORER,
2 [Interface Status] ™A >, A VX —7 = A A%
RS 5 N7 7 4w 7 OBERRIT DI,
AUE =T oA ZAEBRLET,
3 [Connection Status] ™~ >,
4 [CPU Status] ~2A >,
5 [Memory Status] <~ >,
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B ssovzzozs

=1L = 2
ASDM ExE D E ==
KrE D ASDM iR EDEMEZ B TE £ 77,
ASDM O X F X ERHELEF T 5001, WOFIEEZFATLET,

FIE

AT w71 [Tools] > [Preferences] DIEIZEIN L £,

[General], [Rules Table], 35 U [Syslog] D 3 DD X 7 D % [Preferences] XA 7 27K v 7 A
DERRSNET,

AT9 T2 BEEZEFRT DI, 60X TD12%27 U v 7 LET, [General]| ¥ 7 CIXILHT Y 7 7
L A %48 L. [Rules Table] # 7 CiX [Rules] 7—7 VD7V 77 LU A&EBELET, *
72, [Syslog] # 7 Cl%, [Home] A NIEKRIILD syslog A v =V OIMBAZTRE LD,
NetFlow B syslog A v Z—YDELE X v —VDFREA F—T VI LT TEET,
AT w73 [General] ¥ 7 Clx, ROEHEZRELET,

ARG bT T AT 4 Falb—vartErar 74 Xab—va VARSI LTHRN
XTI ND L DIZT HYA1E. [Warn that configuration in ASDM is out of sync with the
configuration in ASA] F = v 7 Ry 7 A% AT LET,

o ELEIIIC read-only T — P —Zx%f L TRD A v — & FoRkT 5841, [Show configuration
restriction message toread-onlyuser] &= v 7 R v 7 A&E AN LET, TOFT T3 U,
T 7N b THTY,

“You are not allowed to modify the ASA configuration,
because you do not have sufficient privileges.”

c AL —7 o=y MR SN2 — P —ITRERIRA v & — %2 FRT 5I1T1E, [Show
configuration restriction message on a slave unit in an ASA cluster] = v 7 R v 7 A% 4 12

Li‘é‘o

«ASDMZHU % L IR T2ERTH 7 7 IRFREND XL HI2T5121E, [Confirm
before exiting from | F= v 7Ry 7 A& F N LET, ZOF T aii, T 74NV T
T,

e AV =2 U —H—% A RX—TMIZF HIZIX, [Enable screen reader support (requires ASDM
restart)]| = v VR J AEANZLET, O T arEAL RF—T I T HITIE,
ASDM Z HEE§ 2 MER H Y £,

« ASA AEY OF/NEZHREN, ASDM 7 7Y r— 3 U OFERIEREE FATT DI
+0THHEEITEMNEZ(ET HI1Z1E. [Warn of insufficient ASA memory when ASDM loads]
F xRy I AeA AT LET, ASDM 1L, EEIFRFHZT F A K N — X vE—TC A
FTVELEEZLIRL, ASDM DX A ML R— T X R MIA v —T%FR L, 24 B 2L
\Zsyslog 77— hEEELET,

B ASMSS T4 AL aA—H—A28—T(R
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ASDM 5% 7€ D FE &

* [Communications] B T :

s ASDM IZ X » TAR &5 CLI 2= REFART HIZIE, [Preview commands before
sending them to the device] = v 7 R v 7 A& AN L ET,

s ASAIZHEH D a~ 2 FE1 5D 7 NV—7 & L TE(ET 5I21E, [Enable cumulative (batch)
CLI delivery] F= v 7 Ry 7 A% A A2 LET,

* [Minimum Configuration Sending Timeout] 7 4 —/V NIZZ# A AT 7 k A v E—Y DEEF
REDRERMZDHEMNMTADNLET, 774/ MI 60T,

e NF AT FANE— RO AT LTI, [Graph User time interval in System Context]
74—/ RIZ, [Home] A > D7 Z 7 OFEFHMREOEEM % 1 ~40 B OHPHCTATI L
£9. 774N MII0BTT,

* [Logging] FEIK T :

e Java B X 2 V& ET HIZIE, [Enable logging to the ASDM Java console] F = » 27 7~
JA%F AT LET,

s Rr Y7 H o URRMMD [Logging Level] %I LT, ERELZRELET,

* [Packet Capture Wizard] ik C, & v 7' F v 7237 > & ERRT 5HI21E, [Network Sniffer
Application] |24 Hi1% AJJT D, [Browse] 227 Vw7 LTCT7 7 AV VAT L THRELE
j—O

* [SFR Location Wizard] 81k T, ASA FirePOWER £ = — /LD — A VERT 7 A4 VoA
VAN AT DG EEE LET, RESINEHEITOE L TRt /AR A FF o
TWDLRENRDH Y £7°,

AT 74 [Rules Table] ¥ 7T, WDOEHZEZREL T,
« [Display settings] Ci%, [Rules] 7—7 /L CON—VDFRFEEZEETEET,
* Auto-Expand Prefix X EIZESWTHBEH INZRX Yy NV —2 B —E R 47

VxJ N IN—T%FRT BHIZIE, [Auto-expand network and service object groups with
specified prefix] &= v 7 R v 7 A& AN LET,

* [Auto-Expand Prefix] 7 « —/L K2, FRT 5 & EICHBNICREETA XY hT—7 %
TV =R LT =2 N IN—TDT VT 47 A AT LET,

Xy NTV—I BRIV —ER ATV N TNV—TDAN=EZD T N—T 4%
[Rules] 7 — 7 /VIZFK/RT 5 IZ1E, [Show members of network and service object groups]
Frv IRy I AeF AN LET, T2y IRy I ABRTTOEET, TV—T472
IRFRRSNET,

* [Limit Members To] 7 4 —/V RIZ, R THX Y NV B —ER A7V
N IN—=TDEEANTILET, 7V N TN—TF AU NR—NEKREIND L X
3. IO nHD A A= RFETRENET,
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* [Rules] 7—7 /AT XRTDOT 7 a &R d 51T, [Show all actions for service
policyrules] = v 7R 7 A% AN LET, A7OHEIEL, P~V —RERRINE
‘a—O

* [Deployment Settings] Ti%. [Rules] 7 — 7 /VZEHENEZ#H T 5 & & D ASA OENIEEZ R
ETEET,
CHLWT 78RR NEEAT S EXIINATT—T V%27 U 74 5I21E, [Issue“clear
xlate” command when deploying access lists] 7= v 7 Ry 7 24 N2 LEd, Z O
0 LV, ASATERESNDT 7R URRIR, TXTOEHET KL RIZx L THE
WA ENAD L2 LET,

» [Access Rule Hit Count Settings] Tld. [AccessRules] 7—7 VDt v MNgET v 75— T
LRELAZFRECEET, by MUT, R — T EH SE T, BRI —
LDt v ML, [Access Rules] 7 — 7 JTITRTRENEE A,

s [Access Rules] 7—7 /L Ct v NENRHBIMIZT v 7T —hSNd X HI23 D12
[Update access rule hit counts automatically] 7= v 7 R 7 A& A A2 LET,

e [AccessRules] 7 —7 /W2, by NI T L FHTHHELAENTHRELET, A
B DOFLFHIL 10 ~ 86400 5T,

AT v F5 [Syslogl] # 7 Clix, WOHEHZRELET,

* [Syslog Colors] fEIE Cix, BERE L~V T L IZE RO ERTRAZHEL, A V‘E%Vﬁﬂ?
AL~ A RATEET, [Severity] 7 7 LlITid, FEKELNABNLETBLOESZ
FRENET, FEREL N TA v =Y EOEITNTRAEZEET LI, X]LTE
TBEHT %7 Vw7 LET, [PickaColor] ¥4 7R TRy 7 ANERINET, ROV
TNNDOX T2V T LET,

o [Swatches] # 7 C/NL v hILEERINL, [OK] 227V v 7 LET,
«[HSB] # 7 CTH, S. BOEELZMEL. [OK]ZZ7 Vv 7 LET,
* [RGB] # 7 TR, ¥k, BOREZXHEEL, [OK] 227V v 7 LET,
c LR ZRsyslog A v —VET 48— NMITHLIBET LA vE—VORTEA K —

LIZF 5 ITIE, [NetFlow] i1k T [Warn to disable redundant syslog messages when NetFlow
action is first applied to the global service policy rule] &= v 7 AR v 7 A& AN LET,

ATYT6 ZNH3ODHTOREEIFE L% T, [OK] 227V v 7 UTEREZIRT L. [Preferences] ¥
ATl Ry AEBALTET,
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ASDM Assistant TD& %R .

GE) TV 77V AREEAFRITIAZICTHZO0NT, BENRIL conf 7 7 A VIR
&N, TOETY—7 25— a vy ETHEITHOZDMD ASDM & v 3 3 )
SRAFATED LR 3, T_RTOEFEZACT SHI21E, ASDM Z fFHiLH+5
MERDY £9,

ASDM Assistant TODH&E

ASDM Assistant Y —/LTld, Z A7 1Z0tx U7z ASDM O FEO~LV T ERER L, FoRTE
N

EHRICT 7 & 29 5 121% [View] >[ASDM Assistant] >[How Do 1?] DJEISEIRGT 50>, A ==2—
/N—® [Look For] 7 4 —/V R GIRBERZ AN LET, [Find] Rry 7 X7 UX R0
[How Do 17] 238 L CHRZRME L £,

ASDM Assistant 2R 9 H1201%, ROFNEEZEITLET,

FIE

AT w71 [View] > [ASDM Assistant] Z &R L £,
[ASDM Assistant] ~A1 VPR RS IVET,

R Fw 72 [Search] 7 4 —/b RICHRZET HERAEASILT[Gol 2 Vv LET,
PR I N7 EEH D [Search Results] XA N FKRINET,

AT w73 [SearchResults] £ 7 ¥ a B X [Features] © 7 v a VIZERSINDEEDO) 7 %27 ) vV
L. FEHRE AFELET,

—te
BEEA L) v DEZE
[History Metrics] ~31 > Cl, S E I ERFEHEROBIELZIRIFT H L O IC ASA R ETE,
ASDMZFERH L CENE T T 7RT7T —T MR R TEET, BEA N v 724 X—TNICL

G E, BETE 203D TAZA LAOKEHERIZT T, BEA N v 7 2 A X—=T NI
T &L EATO 10 7, 60 43, 12 K, 5 HEO#GEHY 7 7 2R R TE £9

JBIEA Y w7 ZRET DI, ROFIREZFATLET,

FIE

AT w71 [Configuration] > [Device Management] > [Advanced] > [History Metrics] % #R L £,
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[History Metrics] ~A » NFR RS IET,

AT 72 [ASDM History Metrics] = v 7 R 7 A% A N LU TEHEA N v 7 A F—T I L,
[Applyl 27 U v 7 LET,

HR— kSN TUWWEWNIaTUF

ASA TEFAIRE/e 2~ RIRIFZ L A ETRTASDM THAR— FshETR, BEfFD=a 7 ¢
Fal—rvaroavwy RKO—HIXTEHEINLIGANOV ET, ZhoDavy RoFEA
a4 Xalb—ra AT ZENTEET, FIC OV TIE, [Tools]>[Show Commands
Ignored by ASDM on Device] & L CT< 72X\,

BAShAIRTEHIATUF

WDOFIZ, CLIHATENENTZHBEICASDM Oy 7 4 Fab—a  THR—FEND
23, ASDM CiEMFEIdRETE RV a~vr Fo—EE2/ L %9, ASDM CTEHINS a~
¥ FIZASDM @ GUI IZ—UI& R ENET A, RRFHFHa~ 2 FIEGULICERRSNET D, iR
HLIXTEERFA,

KR5:HYR—rShTWgELhavw o FO—E

HYR—rEhTWEWNIATU R ASDM D Eh{E

capture \EHINET,

coredump MR SNET, 2T, CLIZHEA L CORHFETE
EJeaN

crypto engine lar ge-mod-accel AR X NFET,

dhcp-server (k> RV Zb—T7%— |ASDM Tix, 9XT® DHCP #—_—{Zxf LT 1>

e ) DIRED DT SIET,

gject PAR— F x5

established EmHEINET,

failover timeout R INET,

fips WA ET,

nat-assigned-to-public-ip I XL ET

pager BAINET,
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YR—rShTOENITY ROEE .

YR—rShTWWaEnwav o R ASDM D EE

pim accept-register route-map M S ET, ASDM T [List] &7 a IR E
ﬂ‘o

service-palicy global match access-list 7 7 A Tl Hl STV D555 1L HEH,

WK 2R LT

access-list myacl extended permit ip any any
class-map mycm
match access-list myacl
policy-map mypm
class mycm
inspect ftp
service-policy mypm global

set metric R INET,
sysopt nodnsalias I ET,
sysopt uauth allow-http-cache AR XN FET,
terminal EHINET,
threat-detection rate BREINET,

HR—hrShTWgEWavy KOEE

PBAFOFETary 7 4 Falb—ra& ASDMICr— RLESA, T2 R— bxtgsto=
~ Y R ->Th, ASDMOBIEICITEL A, FPR— MO a~ s FERRTHIC
&, [Tools] > [Show Commands Ignored by ASDM on Device] % R L ¥ 7,

HBR— RN OER L TGS TRy b TR

ASDM Tid. 255.255.0255 D L H I8 L TCWARWY T Ry F v A7 T R— RSN TWE
A, 72E 2, WA TEEEA,

ip address inside 192.168.2.1 255.255.0.255

ASDM CLI 'Y — )L THR— FERTWENS V859 F 4 T 1—H—
m vVl N

ASDMCLI Y —/Vix, A V¥ T 0T 47 2—HW—avw> FEHFR—FLTWEHA, 1%
TIT 4TI ENELE TS CLI a~y REAIT 5L, [[yesmol)] ODATZERT LT
0y EIRFEREINETH, ANNEITRHE SN ERE A, KT ASDM X, 6B O E &
ALTYURLET,
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RIZH 2~ L ET,
1. [Tools] > [Command LineInterface] iR L %9,
2. cryptokey generatersa =~ > K& AN LE9,
T 74/ D 1024 B b RSA F— A SN ET,
3. cryptokey generatersa =~ REZFHEAN L £,
LIRTD RSA ¥ —% E#EE L THAERT 2O TIERL, ROTT—RRREINET,

Do you really want to replace them? [yes/no]:WARNING: You already have
RSA ke0000000000000$A key
Input line must be less than 16 characters in length.

%Please answer 'yes' or 'no'.
Do you really want to replace them [yes/no]:

SERROR: Timed out waiting for a response.
ERROR: Failed to create new RSA keys names <Default-RSA-key>

[FIEESR
* [ASDM] XA b, =P =N ARMERIEFEAED I~y RERETEET,

snoconfirmz>7> a N HBHCLIa~ > FIZHOWTiE, CLIZ~y RAJERZZOA47 v 3
CEMHLES, WRICFlERLET,

crypto key generate rsa noconfirm
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